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The following icons are used in this user manual:

The information icon precedes important information.

& | Theexample icon indicates a practical illustration of a process or procedure.

The hint icon indicates a suggestion or hint to guide or assist you with performing a
task.

v | The warning icon precedesa warning against potential mistakes and actions that could
~ | cause critical error.
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Congratulations on choosing Attix5 Pro Server Edition. Attix5 Pro minimises risk, maximises
productivity and allows businesses to regain control of their most valuable asset - their data.

For technical support, pleasego to Help > About Attix5 Pro SE , and then use the contact
details provided.

With Attix5 Pro Server Edition (SE), data stored on servers and databases can be backed up to a
Storage Platform quickly, securely and automatically.

The following diagram illustrates the scenario:

Files and folders stored on one or more

Storage Platform

servers running SE can be backed up to
a Storage Platform. In the event of data
loss or corruption on the server, you
can retrieve data from the Storage
Platform and restore it to the original
or another server in just a few easy

steps.

SE

©iStockphoto.com/alexsl| ©iStockphoto.com/ zentilia

A Backup Administrator can manage the entire backup environment (Backup Clients and the
Storage Platform) remotely, using the Attix5 Pro Storage Platform Console. For more
information, please refer to the Attix5 Pro Storage Platform Console User Manual
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1. Getting started

Enabling manual or automatic backups is easy with Attix5 Pro Server Edition:

| ) o

BACK UP
Automaticallyor
manually

Create a Backup Select files and
gystal SE Acount folders for backup

(See page 13) (See page 39) (See pages 49%51)

(See page 7)

ﬂ Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .
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Below are the systemrequirements for Attix5 Pro Server Edition.
System requirements

Operating System

SEis available for the following Microsoft operating systems:
A Windows Server 2008 (Incl. Small Business Server bundles)
A Windows Server 2003 (Incl. Small Business Server bundles)

Processor & Memory

Required: PowerPC G3 with 256MB memory above operating requirements.

Recommendation table

Less than 200 GB Pentium 4, Entry level 1GB

200 - 500 GB Pentium 4, 2.0 GHz 1GB

500GB-1TB Dual Xeon, 3 GHz+ 2 GB
Disk Space

A Required :50 MB plus space for local cache.

i

Note: Please ensure thatthe drive on which the Backup Client will be installed has
enough free space to storecopies of the selected files.

A Recommended: Amount of free space equal to the Backup Account limit if Binary
Patching is enabled. The space requirement for Delta Blocking is considerably less. For
more information, see Patching in Chapter5, fABackups. 0

=

i

Example : To back up 10 GB of data, at least 10 GB of available free spaceis
required on the drive containing the working folders .

Note: Plug-ins may also require additional working space. For more
information, please refer to the applicable plug -in documentation.

StorageServer : The local cache can be as large as the total size of all fileicluded in
the backup selection.

= | Example : A 10 GBinclusion may require up to 10 GB free space for the cache.

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .
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Database (using Database plug -in) : Space isrequired for the data dump (which
can be as large as the databageand as well the cache(which is the compressed version
of the databasé. Assuming 1:2 compression on a 10GB database you are recommended
to have 15GB (10 GB for the dump and 5 GB for the cache) free space available.
Temporary working space is also required for subsequent backups; the requirement will
be less than 5GB in the above-mentioned example.

Minimum video requirements: 800 x 600 Resolution, 256 colours
Virtual memory: Double the amount of RAM, with a minimum of 512 MB (Total for

all disk volumes)
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The SE MSI file contains pre -configured information to make installing SE quick and easy. For
more information on creating MSI files and launching them from the Run Command, please
refer to the Attix5 Pro Storage Platform Console User Manual

i The options available during the installation process depend on the settings
enabled by the administrator when the MSI file was created. These options range from
advanced install settings to specifying the install location. The default install path is
C:\ Program Files \ Attix5 Pro SE

v | Warning:  Before installing, please note:

Both antivirus software scans and backup processes are resource-intensive.

It is advised not to run a backup and virus scan at the same time as this will
significantly decrease machine performance.

To install Attix5 Pro SE:

1. Run the MSI file.
2. Inthe Attix5 Pro SE Setup Wizard that appears, follow the steps as described below.
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The Attix5 Pro SE Setup Wizard typically consists of five stepsto guide you through the Setup
task in a simple, step-by-step manner. These steps also make it possible to undo previous
operations by navigating backward.

Some of the settings described below may have been removedwhen the MSI was
created. Furthermore, the wizard may contain additional step s. Please read
eachwindow carefully before continuing.

If you receive a Windows User Account Control message, asking you if you wish

to allow the Attix5 Pro program to make changes to the computer, click Yes to
proceed.

To start the Setup Wizard: 5 At Pro SE Setup == ==

Click Next . Welcome to the AttixS Pro SE Setup

Wizard

The Setup Wizard will install AttixS Pro SE on your computer,
Click Mext to continue or Cancel to exit the Setup Ywizard.,

ATTIX’Dro

Back.

| Cancel |

To enable the Backup Client to read all files that must be backed up, it may be necessary for the
Backup Client service to run under a specific Windows account.

To specify which Windows account 15! AttisS Pro SE Setup [E=SE=l 5
. . Service User Account
S h O u |d ru n th e baCku p Se rvi Ce " Nomga\lyhthe b.;cﬁup service runs under the LocalSystem account, but that [ i@
can be changed here,

SelectRun as LocalSystem
Alternatively, specify a specific

. . Fun under this user account:
Windows user account: P
1. Select Run under this .9, Domaiser
Passward:
user account . —

Yalidate

| Back |[ Mext ] ‘ Cancel |
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Click the Validate button.

S R

To specify a destination for the SE
application files and folders:

Click Next to accept the default
destination folder and continue to
the next wizard step.
Alternatively, specify a new
destination folder:

1. Click the Change button.

2. Browse to the folder.

3. Click OK.

4. Click Next to continue to

the next wizard step.

In the User Name box, type the Windows user name for the account.
In the Password box, type the Windows user accountpassword.

Once the Windows user account has been validated, clickNext .

50 AttiS Pro SE Setup

Destination Folder

Click Mext to install to the default folder or cick Change to choose another.

Install AttixS Pro SE bo:

=l = =

5

|C:\Prugram Files\Attix5 Pro\Backup Client SEY

change. ..

EBack |[ et

| Cancel

Once all the settings are configured, the wizard is ready to begin the installation.

To begin the SE installation

Click Install

5 AttixS Pro SE Setup

Ready to install Attix5 Pro SE

=l =@ ==

15

Click Install ta begin the installation. Click Back ko review ar change any of your

installation settings. Click Cancel ko exit the wizard.

Back |[ % Install

| Cancel
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The last step of the wizard presents the 180 Attics Pro SE Setup o) = s
option to launch the Backup Client. .

Completed the AttixS Pro SE Setup

Wizard
TO |aUI’]Ch the BaCkUp Cllent Click the Finish button to exit the Setup Wizard,
immediately after the Setup
Wizard:

1. Ensure that the Launch Backup
Client SE check boxis selected.
2. Click Finish .

/| Launch Backup Client SE

ATTIX®Pro

Back Cancel

If the MSI file is being run from the same location as the plug -in installer file, the
Setup Wizard will give you the option to launch the plug -in installer before
launching the Client. Select the Launch Plug -in Installer  check box to runiit
immediately after the Attix5 Pro SE Setup Wizard. For more information about
plug-ins, please refer to the Attix5 Pro  Server Edi tion Plug -ins user

manual

Before the Plug-in Installer launches, a User Account Control dialog box may
appear, asking you if you wish to allow the Plug -in Installer to make changes to
the computer. Click Yes to run the installer .

If you selected the Launch Backup Client SE check box in the last step of the Attix5 Pro SE
Setup Wizard, the Backup Client will open automatically upon clicking Finish and the Backup
Account Setup Wizard will launch, enabling you to create a Backup Account. Follow the
wizard steps as described n Chapter 3, AAccount setup. O

If you opted not to launch the Backup Client immediately, you can open the Client interface at a
later stage via the Start menu or by following any of the instructions listed under Opening the
Backup Client in Chapter 4, iGraphical User I nterfacebo

i) The Account Setup Wizard will launch when you open the Backup Client for the
firsttme. See AAccount Setupo bel ow.
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To backup or restore data using the Backup Client, a Backup Account is required.

If you selectedthe Launch Backup Client SE check box in the last step of theAttix5 Pro SE

Setup Wizard (see The Attix5 Pro SE Setup Wizard in Chapter 2, fil nst)athelBackupo n o
Client will run and display the Backup Account Wizard automatically. Use thi s wizard to set up a
Backup Account by following the steps as described below.

If the Launch Backup Client SE check box was not selected in the last step of theéSE Setup

Wizard, the Account Setup Wizard will launch when the Backup Client is opened for the first

time (for more information, see Opening the Backup Clienti n Chapt er 4, AGraphic
I nterfaceod).

i) To run the Account Setup Wizard at any other time : On the Tools menu, click
Account Setup Wizard . In the warning box that appears, click the Run Account
Setup Wizard  button and follow the instructions below from Step 2 (below) onwards .
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The Account Setup Wizard typically consists of eight stepsto guide you through the Setup task
in a simple, step-by-step manner. These steps also make it possible to undo previous operations
by navigating backward.

i) Some of the settings encountered in the wizard may have been removed when the
MSI was created. Furthermore, the wizard may contain additional step s. Please read
eachwindow carefully before continuing.

i) This step displays when the wizard is run directly after the SE Client installation.
If accessing the wizard at a later stage ( via the Tools menu), this step will not display as
the Storage Platform settings will already have been configured.

To specify the Storage Platform Bl pecounsSeup i o %
connection settings: 1%

Please contact your backup administrator I you do not have the required information.

Storage Platform Settings

1. In the Storage Platform
address box, type the IP address
or DNS name of the Storage
Platform  where the Backup
Account resides.

2. Inthe Group name field, specify
which Backup Group the Account

m address: |192,168,20.215
A-5P OWNERIRESELLER AlBACKUP ACCOUNTS

ATTIX’Pro
belongs to. [ ] e e
i) Type the Group &
| name in relation to COLLECTIONA COLLECTIONB GROUP
any Collections it may
belong to.

3. In the Group create key field, specify the preconfigured Group create key for the
applicable Group. If you do not have access to this key, please contact your Storage
Platform administrator.

4. Once all the correct settings have been entered, lick Next .
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i)
' This wizard step is typically the first to be displayed if you access the wizard via
the Tools menu.
You can selectl want to connect to an existing Backup Account to:
Connect to an Account that has been opened for useby this computer.
Reconnect to an Account to recover data from the computer that had
previously backed up to this Account.
To create a new Backup Account: B Accoune et Waar =
Specify the account type.
1. Se|ect| Want to Create a neW g‘rfv;urs:mb:t:;‘er:v;lnewwex\stmgﬁackﬁuuAccuunt‘Vuu:annutwnnecttuthesameBa:kupA:(uuntFrum [L@
Backup Account . S
@ {want to create a new Backup Account
2_ C“Ck Next . Iwanttntnnne[ttnanex\st\igﬁa(kuukmunt
To connect to an existing account:
1. Select!l want to connect to an
existing Backup Account
. . 5
/% | Warning:  Different il
servers cannot back up to s [ <2 (alizie) (acuc

the same Backup Account.
A separate Backup Account
needs to be created for each
server.

2. Click Next to continue.
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Depending on the option you selected in the previous step, you will either be prompted to

specify new Account details or to supply
the already configured details of the
existing Account.

To specify new Account details:

1. In the Backup Account name
box, type an Account name that
consists of a minimum of 4
characters.

2. In the Account
type a password that consists of a
minimum of 4 characters.

3. In the Confirm password box,

password  box,

repeat the Account password entered in the Account password
box, type an encryption key that consists of a minimum of 8

4. In the Encryption key
characters.

v | Warning

[E] 2ccount Setup \izard

Enter the new account details. [ @

Choose and enter your preferred account name, password and encryplion key.

Account Details
Backup Accourk name: | BACKUP ACCOUNT 01

account password: | eesese

Confirmpassword: | esesse
Pleass choose an encryption key of & characters or more that will be used to encrypt your backups on
the server. Noke: If youlse this key you wil not be able ko restore your data, so write it down and

store it somewhere safe,

Encryptionkey:  essesess

Confimkey:  eeseseee

ATTIX?Dro

pelp | [ <Back | [ het> | [ cancel

box above.

. Disaster recovery is not possible without the encryption key. Please

ensure that this key is kept in a safe place. THE ENCRYPTION KEY IS NOT
STORED ON THE STORAGE PLATFORM AND CANNOT BE RECOVERED OR

RESET IF LOST.

5. Click Next .

When connecting to an existing
Account:

1. In the Backup Account name
box, type the Account name.

2. In the Account password box,
type the Account password.

3. In the Encryption key  box, type
the encryption key chosen when
the Backup Account wascreated.

[Edl Account Setup Wizard

e

Enter the new account details,
hoose and enter your preferred account name, password and encryption key. [

Account Details
Backup Accourt name: BACKUP ACCOUNT 01|

Account password; | esseee

Encrypiionkey:  esessees

Hinimum & char acters

ATTIXDro

Help. H < Back |[ Hext > H Cancel
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To specify the connection settings:

1. In the Connection Settings area,
select | use broadband or
another permanent network
connection

2. If a proxy server will be used:

2.1. Click the Configure
Proxy button.

2.2. In the Proxy Setup dialog
box that appears, select a
proxy type.

2.3. If Use SOCKSvV5 Proxy or

Use HTTP Proxy is selected, fill in the Proxy Host

[Edl 2ccount Setup \izard
What kind of connection do you have?
Select the type of connection that you Use ko connect ko the Internet.
Connection Settings

%) 1 use a modem/diakup connection.

@ {3 bioadband of anSther pefmanent nebwor: connectior

Configure Proxy

ATTI?Dro

top | [ <Back |[ het> ][ cancel

and Proxy Port  boxes.

2.4. If login details are required, select the Proxy server requires authentication
check box and type the username and password in theboxes provided.
2.5. Click OK to close the Proxy Setup dialog box.
3. Click Next to move to the next step in the wizard.
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Attix5 Pro can run backups on included files and folders either upon request (manually) or
automatically. This step enables you to set up a backup schedule.

It is advised to back up at
night when the server is running
and the Backup Client is not in use.
The server must be switched on at
the time(s) specified for scheduled
backups, but the Windows user
doesnot needto be logged in.

To configure the Backup Client to
run only manual backups:

1.

Clear the Daily automatic
backups check box

Click Next to move to the next
step in the wizard.

[Ed] Account Setup Wizard

Do you want to schedule automated backups?
Spedfy the dally and hourly backup schedule, You

Automatic Backups

Back up at the Following times

Week Day

are strongly recommended to enable automatic backups, t

Back up every day at: =

[ ] Advanced Schedule

==
@

Additional Schedule

Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
Sunday

Bockuptime:
= zhoo | @D
Add

Delete

ATTIX®Dro

Hep | [ <Back | [ mest> | [ Cancel

Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is

strongly ad vised.

To schedule daily automatic backups

Select theD aily automatic backups

check box

In the Back up every day at  box, specify a backup time.
Click Next to move to the next step in the wizard or schedule additional advanced

backups as described below.

To schedule advanced backups:

o s wn

Selectthe Advanced Schedule check box.
In the Week Dayarea, selecta day on which a backup should be initiated.

Specify the time in the Backup time

box.

Click the Add button to add the day and time to the Additional Schedule box.
Repeat the steps above until you have added all desired schedules to theAdditional

Schedule box.

Click Next to move to the next step in the wizard.
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Under normal circumstances, the default [E Account Satup Wiz

=
Do you want to modify the default working folders?
Temp , Cache, Logs and Database T o e e ot s e [g_@
folder locations can be accepted andyou v
Mote: Always keep these folders on the same drivefvolume.
can click Next without making any e |ChProstam st P Clert SEaBecp browe.

o . . Cache: C:\ngvam FI\ES\Att\xSPm\BaEkuD(I\EntEE\(aEhE Browse. .,
mOdIflcatlonS If’ hOWGVEI’, the drlve On Logs: C:\Program Files|AttixS ProtBackup Clhent SEllogs Browse. ..
Wthh the Backup Cllent |S InSta”ed has Database: CH\Program Files|AttxS ProjBackup Client SE Browse.
limited space available, you can move the
folders and selection databaseto another
location.

ATTIX®Pro
v | Warning:  Pleaseensure that these [ ot | LREEE] [ e

folders are located on a drive with
sufficient free space.

To change the temp , cache, logs and/or database folder locations:

1. Click the Browse button next to the appropriate box (e.g. Temp ), and then select a
different location for that folder.

2. Repeat step 1 above until all folder locations are correctly specified.

3. Click Next to continue with the installation process.

v | Warning: The Cache and Temp folders must reside on the samedrive/volume.



Attix5 Pro V6.0 installs with Emall
notification and System state plug-ins by
default. In this step, you can configure
these plug-ins or accept their default
configuration and proceed to the next step

in the wizard.

To configure a plug  -in:

1.

In the Configurable plug-ins list,
click the plug-in name.

Click the Configure button.
Configure the settings as required.

(For more information on configurationopt i on s ,

ATTIX’

The Follawing plugrins can be configured now, or yau can co
w option,

| Plug-ins menu option

rfigure them later via the Tools [ @

ATTIX?Dro

Hep | [ <Bad | [ Hext> || Cancel

S

Click OK to close the dialog box and return to the wizard.

Click Next to continue to the next step in the wizard.

ee Chiarpg®e.r) 9, APl ug
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In the final step of the Account Setup I pecount st Wi =
Confirm your account settings.
W|Zard' a Summary screen d|sp|ays a ||St 1f the settings below are correct then dlick Next, otherwise click Back ko change your settings. [i@
of the configured settings.
ALtixS Pro 5E Username: BACKUP ACCOUNT 01
Connection methad: Local Area Network

Automatic backups:

To confirm the Setup information: i

1. Read and \verify that the
information is correct, and then
click Next .

2. The Backup Client will connect to A

ATTIX Pro
the  Storage Platform and e A

19h00

configure the Backup Account. A

message Wwill be displayed to
. [Ed] Account Setup Wizard (=)
confirm that the Account was set Setup Wizard Completed

The next step is bo canfigure the backup selection lst, You can inchude files, Folders and use selection fiters.
Refer to the Backup Clent Help section for [

up successfully. Fatoe o i
3. Click OK to close the message

“four account has been created successfully.
Group: A-SP OWNERVRESELLER AVBACKUP ACCOUNTS
bOX Username: BACKUP ACCOUNT 01

. Account size: 1024 MEB

“fou may now proceed to select files and folders for backup

The Setup Wizard Completed screen will
confirm the Account creation /connection .

Now that a Backup Account has been .
configured/you have connected to an

Account on the Storage Platform, you can
select the files and folders you wish to
back up.
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You can use the Graphical User Interface (GUI) to:

Select files for backup

Launch backups

Schedule automatic backups

Find files in previous backups

Restore files and folders from previous backups
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Opening the Backup Client interface

To open the SE Client interface:

On the Start menu, point to All Programs , point to Attix5 Pro , and then click Backup
Client SE .

‘ @ Default Programs
W Desktop Gadget Gallery
& Internet Explorer
) Windaws DVD Maker
E58) Windowes Fax and Scan EE
 vindows Media Center
@ Windows Media Player
E'_| Windows Update
o ¥PE Wiewer
L. Accessories helshe
Lo Atih Pro
 [B] Backup Client;SE Games

|, Storage Platforin

| Gamnes Computer

Documents

Pictures

, Maintenance
, Microsoft Office Control Panel
| Startup
Dewvices and Printers

Default Pragrarms

Help and Support

P allPrograms Wird o

| Search progrors and files

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .
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Alternatively, if the Client interface is closed but the service isstill running (if the 5 icon displays
in the system tray), double-click the Attix5 Pro icon or right -click it, and then click Open :

Open

Backup Mo

Cancel Backup

Monitor Status
Motifications r
Shout

E:it i

 — .
CRox e 1/8/2010 |

i) | Note: The firsttime you open the Backup Client, the Account Setup Wizard launches
automatically . For more information on creating a Backup Account,seeChapt er 3,
setup. o

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .



The Client interface explained

You can manage and monitor backups using the Backup Client application window, the system
tray icon or the notification bubbles that appear when certain processes occur. Below are
descriptions of each of these items and the options they provide.

Application window

The Backup Client application window contains the following areas:

[Ed] Attix5 Pro SE VDD

Fie Selection Tooks Help

<

Menu bar

)

'S

Q@

Options Automate m

: & Product Help

Backup Size Restore  Find A
& Backup Selection | | Restare | =] Logs|
@l My Computer ] lename Size Date
RS C: L §Recyde.Bin 2009-11-12 12:18:27
L~ $Recycle Bin L= Corfig.Msi 2010-01-18 09:35:08
L= Config Msi L= MSOCache 2009-11-12 12:35:01
(= MSOCache L= Perflogs 2009-07-14 04:37:05
4~ PerfLogs L= Program Files 2010-01-16 18:45:06
[+ = Program Files L= ProgramData 2009-11-20 10:05:44
[ ProgramData L= Recovery 2009-11-12 12:17:55
61|~ Recovery L= System Volume Information 2010-01-18 10:07:30
(-4 = System Volume Inf | | = Ugers 2009-11-12 12;
G| Users L Windows 2008 Tenz:se
1 Windows € autoexec.bat 03-06-10 Z3:42:20
1% system State Plug-n || € config.sys TKE  2008-06-10 23:42:20
O hiberfl.sys 1,965,736 KB 1970-01-01 02:00:00
€ pagsfle.sys 2,620,984 KB 1970-01-01 02:00:00

Quick-start
Step-by-step quide

Backups: How to...
Sellect data
Use selection filtey

Restores: How to...
Restore files and Folders

Find particular files to restare
Restore the backup selection

Options and settings

Connections

1" Display

Disk usage.
Performance and limits
Global filters

Patching

Mandatory pakching
Logaing

Advanced options

Additional information
Resuming backups
Hotifications

Server Edition auto-updates
Concurrent backup processing
Adding network volumes
Remote Management:

Multiple Backup Sets

Health Check

Ready

Qutlook PST files

art
Up manually
achedule automatic backups

Toolbar

\\

-

| — Tabs
| — Product Help

L — Status bar
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Menu bar and toolbar buttons

ATTIX’

All Backup Client functions can be performed from the menu bar. Shortcuts to the most

commonly used menu bar functions are also available on the toolbar and right -click menus.

Menu bar

Each menu on the menu bar contains one or more options. The tables below describe the
options available.

File menu

Backup
Now

Restore

Calculate
Size

Find
Files in
Backups

Export
Selection

Initiate a Backup immediately. @
—_—

Backup

Switch to the Restore view in the Client.

\;2 Tip: For faster access to the Restore view, click ;t.: ;

the Restore tab instead of using the File menu. Restore
Determine the total size of the dataincluded in the backup " @
selection. For more information, see Determining the -

. L ~ Si

backup selectionsizei n Chapter 5, HfABacl e
Access theFind Files in Backups  dialog box. This box —
enables you to search for particular files in your backups. For r@
more information, see Finding files in backups in Chapter 6, Find
ARestores. 0
Export a list of all backup inclusions and exclusions to an Selection Tools Help
html file for future reference. For more information, see Backup Mow
Exporting a selection report Restore

Exit

Calculate Size

Find Files in Backups

Export Selection
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File menu continued...

Exit Close the DL Client application window. X
\J Tip: You can re-open the Client window at any
time via the Windows Start menu or by double-

clicking the icon in the system tray.

Selection menu

Filters > Create a new ISElE':ti':'n] Tocls Help

New Filter filter to Filkers 3 Mew Filker ...
automate Include Faolder Edit Filters ...
inclusions or Exclude Folder © Graphics .
exclusions

_ Deselect Folder ) M5 Access databases »
based on file T M35 Office documents  k
type. For more ReAEln P M3 Outlook emai 3
information, 1 Web pages k
seeUsing
filters in
Chapter 5,
fiBackups

Filters > Edit existing ISEle':ti':'n] Tocls Help :

Edit filters. For Filkers 3 Mew Filker ...

Filters more Include Faolder Edit Filters ...
information, Exclude Faolder O  Graphics "
seeUsin

. ' 9 Dreselect Folder ) M3 fccess databases »
filters in T M35 Office documents  k
Chapter 5, Ritieehn P M3 Outlook emai b
fiBackups 1 wWeb pages ¥
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Selection menu continued...

Filters >
[filter ]>
Include

Filters >
[filter ]>
Exclude

Filters >
[filter ]>
Deselect

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .

Include all files
in the selected
folder that
match the
filterds
For more
information,
seeUsing

filters in
Chapter 5,
fiBackups

Exclude all

files in the
selected folder
that match the
filterds
For more
information,
seeUsing

filters in
Chapter 5,

fiBackups

Clear the
selected folder
of any filters
currently
applied to it.
For more
information,
seeUsing
filters in
Chapter 5,
fiBackups

ISeIectiDn Tools Help

Filters Mew Filker ...
Include Folder Edit Filters ...
elr,
Exclude Faold —H
eeE TEE ) tGraphics g Include
Deselect Folder '
1 M3 Access databases » Exclude
Rafresh 1 M3 Office documents e Deselact
Bires S 1 M3 Qutlaak email 3 FREIEE
T ‘Web pages 3
ISelectiDn Tools Help
Filkers 3 Mew Filker ...
Include Folder Edit Filkers ...
Helr,
Exclude Fold g
rece Foer ) traphics J Include
Deselect Folder \
1 M3 Access databases » Exclude
e T M3 Office documents  k I
BITEs 5 1 M3 Qutlook, email 3 FREIE
1 Web pages 3
ISeIectiDn Tools Help
Filters 3 Mew Filker ...
Include Folder Edit Filters ...
n|n
Exclude Folder . =
©  Graphics b v Include
Deselect Folder !
1 M3 Access databases » Exclude
Refresh 1 M35 Office documents e ——
SirEs s T M35 Outlook email 3 SSEIEC
) web pages 3
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Selection menu continued...

Include
Folder

Exclude
Folder

Deselect
Folder

Refresh

Include the selected folder for backup.

Exclude the selected folder from the backup selection.

Refresh F5
Clear the selected folder of any inclusions or exclusions. |Selection| Tools Help
Filters 3

Refresh the selection being displayed.

ISelectiDn Tools Help

Filkers 3

Include Falder
Exclude Faolder

Deselect Folder

Refresh F5
ISeIectiDn Tools Help
Filkers 3

Include Falder
Exclude Falder

Deselect Folder

Include Folder
Exclude Falder

Deselect Folder

Refresh F5
ISeIectiDn Tools Help
Filkers 3

Include Folder
Exclude Falder

Deselect Folder

Refresh F5
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Tools menu

Add
Network
Volume

Additional
Backup Sets
> Add

Additional
Backup Sets

> Manage

Automatic

Backups

Add a network volume. For more
information, see Add network
volumeinChapter 8, AO

settings. 0

Create additional backup sets. This
enablesyou to have separate backup
selections that you can recoveras
separatesets of files. For more
information, see Multiple Backup
SetsnChapter 8, fAOpt
settings. 0

Access the Backup Schedulgpagein

the Options and Settings dialog

box. Using the settings in this dialog
box, you can manage the schedule(s)
of your backup sets.For more
information, see Multiple Backup
SetsinChapter 8, AOpt
settings. 0

Access the Backup Schedule settings
in the Options and Settings  dialog
box. Configure the settings in the
Automatic Backups area to set up one
or more automatic backups. For more
information, see Scheduling
automatic backups in Chapter 5,
fBackups. o

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .

[Tu:u:uls Help

Add Metwork Volume
Additional Backup Sets »
Aukomatic Backups
Account Setup WWizard

Femoke Management

Health Check. ..

Snapshot 3
Plug-ins 3
Opkions

[Tu:u:uls Help

Add Metwark Yolume M_[

Additional Backup Sets » Add

Account Setup Wizard

[Tl:u:uls Help

Aukamatic Backups Manage

&dd Metwork Yolume
Additional Backup Sets » Add

Aukamatic Backups Manage

Account Setup Wizard

[Tu:u:uls Help

fdd Metwork Yolume
Additional Backup Sets »
Aukamatic Backups
Account Setup Wizard



ATTIX®

Tools menu continued...

Account Launch the Account Setup Wizard, which m Help
Setup enables you to change the Backup Account Add Nebwork Yolume
Wizard settings. For more information, see Account Additional Backup Sets »
SetupWizardinChapt er 3seif At Automatic Backups
Account Setup \Wizard

Remote Management

Remote Access theRemote Management e
Management Settings dialog box. Using the settings e e
available, you can enableRemote
Health Check. ..
Management of the Client via the SP
_ : Snapshaok 3
Console.For more information, see Remote
ManagementinChapt er 8, AOjg LTS g
settings. 0 Cjplfainis
Health Access theHealth Check dialog box. FAREHITE St eard
Check Performing a Health Check enables you to P femeg oot
highlight possible issues. For more
) 2 -p ) Health Check. ..
information, see Health Check in Chapter 8,
5 . . . Snapshaok 3
AfOptions and settings
Plug-ins 3
Options
Snapshot > Accessthe Export Backup Snapshot 3 Export Backup Snapshot
Export dialog box, which enables you to configure ' Import Restore Snanshok
Backup the next backup to bea Snapshotbackup to a
Snapshot specific location. For more information, see
Backup SnapshotsinChapt er 8,
and settings. 0
Snapshot > Accessthe Import  Backup Snapshot Export Backup Snapshot
Import dialog box, which enables you toconfigure » Import: Reskore Snapshot
Restore Restore Snapshot settings. For more
Snapshot information, see Restore Snapshofsin

Chapter 8, fnOpt.ibtons a

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .



7ools menu continued...
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Plug -ins >
Email
Notification

Options

Access theEmail Notification settings 3

dialog box, which you can useto

Ermnail Matificakion

enable/disable Email notification and

configure its settings. For more information,

seeEmail Notification plug-in in Chapter 9,

iPl-iumgs . 0

Opens the Options and Settings

dialog

box that enables you to modify a range of —

Ciplions

Client settings. For more information, see

Chapter 8,

iOpt.ibtons a

Icon
Legend

Product
Help

About
Attix5 Pro

Access a list of the icons
used in the Attix5 Pro
Client and their

meanings.

Access the Product Help.

Access the product
information and support
contact details.
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Product Help
About AktixS Pro SE

©

Help

DIODOO

Icon Legend 3

Praduck Help
Abouk AbkixS Pro SE

File (not selecked)
Included by user
Included by user Filker
Exchuded by user
Exchuded by user filker
Excluded by administrat:

Trarhided bw menFilion
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Tabs

There are three tabs availablein the Backup Client:

Backup Selection: This tab displays the files and folders on the computer, enabling
you to select the items to be backed up For more information , see Selecting data to
backupi n Chapter 5, fABackups. 0

Restore: Use this tab to browse previous backups and restore files and folders.

Logs: Use this tab to view detailed information on each backup and restore.

)

Tip: In the right -hand pane on the Backup Selection  and Restore tabs, you can click
any of the column headings to sort the list according to their values.

i Backup Selection | o Restore | B |=|:||;|5|
=T Computer I Filenarme
B T [ $Recycle.Bin
b~ $Recycle.Bin |~ Config.Msi
L~ Config.Msi L= MsoCache
[+f = M30Cache [~ Perflogs
G-L Perflogs |~ Program Files
L Program Files [~ ProgramData
--L_'. Programbiata |~ Recavery
"L—:- Recovery L= Systern Yolume Information
--L_. System Yolume Inf L= Users
b Usars L= windows
E-L wWindows ™ autoexec,bat
-k System State Plug-in || ~ config.sys
0 hiberfil.sys
0 pagefile.sys
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Product Help

@ You can acess theBackup Client Help by clicking Product Help  on the Help menu.

| Alternatively, click the Help button on the toolbar.
Help

As you navigate the Client, the Help pane will display information relevant to the selectedtab.

@ Product Help @ Product Help
_ * _ *
Ell m| : .y .
Quick-start B ‘fou can restore Files andfor Folders in
Skep-by-skep guide three steps:
Backups: How to... 1. Select data to restore
Select data 2. Start the restore process
Use selection filters 3. Select the restore options
Export & selection report
Back up manually -
Select data b k
Schedule automatic backups electing data to restore
Rest  How ‘ou can kel the Backop Client which
EsLOres: How Lo... files and/or Folders to restore and
Restare files and Folders _ _ o 4
Find particular Files ko restore which ko ignore by clicking the ©
Restore the backup seleckion Restore tab and then including or
- excluding the ikems as described -

Status bar

This area displays the date and time of the last backup performed by the system.

Ready Lask backup:Jan 18, 2010 2:55:31 PM
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System tray icon

The System tray icon [E] indicates the backup activity status and can be used to perform various

tasks.
o An animated icon indicates that the service is busy with a backup process.
Open
Right-click the system tray Backup Mow
icoq to view the menu options Cancel Backup
available . Monitor Status
v Motify on Success Muatifications »
v Motify on Failures About

v Motify an Warnings Eyit

Note: On the Windows 7 operating system, the system tray icon is hidden by default. To
display the icon, click the Show hidden icons  arrow, click Customize . In the dialog
box that appears, expand the Behaviours drop-down next to SERunner.exe , and
then selectShow icon and notifications

Q.:

System tray menu

Open Opens the Attix5 Pro Client application window.

\J Tip: Users can also doubleclick the system tray icon to open the
application window. For more information, seefi Appl i cati o
earlier in this chapter.

Backup Now Manually initiate sthe backup process without opening the Backup Client
application window.

Cancel If the service is busy with a backup (when the [E] icon is animated), Cancel will

Backup stop the process.
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System tray menu  continued...

Monitor Opens a small g =
Status window above the Attix5 Pro SE

system tray Lazt Backup: Today 2:00 P Success

displaying the Mest Backup: Today 700 Pk

progress of the

current process.
This enables you tomonitor the status and progress of the task being performed
without opening the application window.

Notifications Provides you with options to enable/disable backup notifications. For more
information, see fANotificationso | ater
About Displays a window containing the AbouE AR Pre S8 ==

AtES Pro SE V6.0.0
product details. Copyright (£} At 1999-2009

g . . . Product suppart contact information:
CIle anyWheI’e n the WlndOW to Close It. Debug Reseller v, attixS,com

info@atti=S, com

Backup Account:  BACKUP ACCOUNT 01
Backup Group: A-5P OWNERIRESELLER AYBACKUP ACCOUNTS
Shorage Platform: 192,168.20,215

Euild: 635

User status: Registered

Plug-ins lnaded:

- Discavery Plug-in version: 1.0,492

- Email Motification Plug-in version: 2,10,492
- Syskem state Plug-in version: 2.0.515

ATTIX°Pro

Server Edition V6.0

Exit Removesthe lE] icon from the system tray.

gj Note: This will not stop the Attix5 Pro service from running scheduled
backups.

To see the icon in the system tray again, simply open theAttix5 Pro Client interface
using the Windows Start but t on. For more informatio
Client interfaceo earlier in this chap
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1. | Warning:  The Backup Service must be running at all times for backups (manual or
scheduled) to take place.

i To stop or start the Backup Service, open Administrative Tools in the Control

| Panel , and then double-click Services . In the list of services that appear, select Attix5
Pro SE and selectStop or Start on the toolbar. A red cross will appear in the corner of
the system try icon when the service is not running : .
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Notifications

The system tray icon can display a number of notifications once a backup has completed. The
following notifications are available:

Backup successful (popup messagalisplayed for 5 seconds)

Backup successful with errors (message displayed for one minute)

Backup failed (message displayed until you click it) text

When a notification is available, a pop-up will display information. If there were warnings or
errors, the system tray icon will also flash a red cross.

@ Attix5 Pro SE X X Ay Attix5 Pro SE A X

Backup completed successfully. Backup completed successfully but there were warnings
and/or errors, please view backup log for more details.

i) | Note: To view related log file information, click anywhere within the pop  -up.

To disable notifications:

Notifications are enabled by default but you can disable them individually by right -clicking the
system tray icon and then clearing the check mark next to the relevantNotifications  option.

Open
Backup Mow
Cancel Backup

kdonitor Status

Motify on Success Motifications 2
v Maotify an Failures Sbout
v Motify on Warnings
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After installing Attix5 Pro Server Edition (SE) and creating a Backup Account,you can tell the

Backup Client which files and/or folders to back up and which to ignore by creating a backup

selection ( see A Sel dgockadkiom @ 0 d & eYow ean then start a backup manually or

schedule automatic backups ( see HfAPer f or miakmkuao mandaliSbhedul ing a
backupsodo bel ow) .

i) Any changes, additions or deletions to included files and folders will be backed up
intelligently with every manual or scheduled backup.

The following sections describe how to:

Selectdata to back up

Usefilters to specify files and/or folders to be excluded from the backup selection.
Determine the backup selection size

Start backups (automatically and manually)

Resume a failed backup

You can make your first backup selection or modify a backup selection at any time using the
Backup Selection tab as described below.

To select files and folders for backup:

1. Click the Backup Selection tab.

2. In the Backup Selection tree, navigate to the folder or directory containing the file or
folder.

3. Include or exclude files and/or folders, as described below.

Once afile or folder is included in the backup selection, any modifications to it will
w | be backed up automatically. For more informatio n, see PatchinginChapt er 8,
and settings. 0



ATTIX’

To include an individual file:

In the right -hand pane, click the file icon ' or right -click the file name, and then click Include .
An included file is displayed with a green icon: ©

To deselect afile, you can either click the icon again or right-click the file name, and then
click Deselect . A folder containing some included files is displayed with a green tinted icon:
&

To include an entire folder:

Right-click the folder icon -, and then click I nclude Folder . Alternatively, you can select the
folder in the Backup Selection tree, and then click Include Folder on the Selection menu.
Included folders are displayed with a green icon: £

All files in the included folder and its subfolders wil | be included in the next
backup. Any changes made within this folder or its subfolders will automatically be
included as well.

To deselect a folder,right -click the folder icon, and then click Deselect Folder

To exclude a file or subfolder:

If an entire folder is included but you wish to exclude a particular file or subfolder, right-click
the file or folder icon,and then click Exclude or Exclude Folder . Excluded items are
displayed with red icons: & or ¥ Included folders that have some files or sibfolders excluded
are green with a red tint: £

You can create different backup selections for different backup sets. For more
information, see Multiple Backup SetsinCh apt er 8, AOpt.idns
You can usefilters to automate file selection based on file types.

Once you have selected all files to be included and excluded, it may be useful to
check the size of your backup selection before initiating your first backup. For
more information, see Using filters later in this chapter.
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You can use filters to automate file inclusions or exclusions within a folder, based on file types.

x A *.doc filter will include or exclude all Word documents within a folder, as
well as any new Word documents that are added to that folder later.

To apply a predefined filter to a specific folder:
1. Inthe Backup Selection tree, right -click the folder icon.
2. Pointto Filters .
3. Point to one of the available filters in the list (e.g. MS Office documents ).
4. Click Include or Exclude .

To modify an existing filter:
1. In the Backup Selection tree,right-click the folder icon, point to Filters , and then
click Edit filters
2. Select one of the filters andthen modify its properties in the Edit filter  box.
3. Click OK.

To add a new filter from within the Edit filters  dialog box, click the New button, supply
a name that describes the filter, enter the file type(s), and then click OK.

To add a new filter via the Backup Selection tree:

1. Right-click the folder icon, and then click New filter

2. In the Filter name box, type a name to be used in the Filters menu.

3. Inthe Filter box, specify the file extensionsto which the filter will apply.
4. Click OK.

The filter will be added to the Filters menu and you will be able to use it to include or exclude all
files matching its criteria.

To remove filters from a folder:

1. Right-click the folder icon.

2. Pointto Filters .

3. Point to the name of the filter you wish to remove.

4. Clear the check mark next to the selection (nclude or Exclude ).

To identify files and folders selected by filters:

Look at the icon state. Files and folders included in the backup selection by filters display with
icons containing blue check marks: & and (e
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Some inclusions and exclusions are enforced atadministration level on the Storage Platform.
This i s c¢al | Fodmoiepnfoonfitiod, see gPoofiing in Chapt er 8, AOptions
settings. 0

Files and folders affected by profiling display with the following icons :

File inclusion

o Filtered file inclusion
File exclusion
Folder inclusion

¥ Filtered folder inclusion

(x] Folder exclusion

Profiled selections cannot be modified from within the Backup Client and can o nly be
changed on the Storage Platform. For more information, please refer to the Attix5 Pro
Storage Platform Console User Manua l.

Global filters enable you to specify files and/or folders to be excluded from the backup selection.
They also enable you to specify which file typesshould not be compressed before backup.

To add Global Filters:
1. Click the Options button on the toolbar, and then click Global Filters
2. Select the type(s) of filters to apply and then specify their values.(For more information,
seeGlobal Filters i nChapt er 8, AOpt.ibg)hs and settings
3. Click OK.
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i)
pEg

Icon legend

On the Backup Selection tab, each file and folder is displayed with an associated icon The

colour of the icon indicates the file or folderos
ﬂ Backup Selection | i Restore I lg L'I";IS|
il My Computer ' ] Filenarne 5
BaC [ Windows Sidebar
e §Recycle Bin [ & ‘Windows Portable Devices
L: Config,Msi [ & wWindows Photo Viewer
[-Lwf M30Cache [ & Windows MT
E-L Perflogs & wWindows Media Plaver
xR Wl Program Files (¥ Windows Mai
L: ProgramData [ & Windows Journal

The following icon legend lists the Attix5 Pro icons and the statuses they indicate. You can
access this legend byclicking Icon Legend on the Help menu.

Note: For more information on backup s el e B8dettiogn
dat a t o earBecikthisichapter.

Icon legend

C File (not selected) The file exists in the folder or directory but is not included in

the backup selection (neither included nor excluded).

[ Selected by user The Backup Client user hasincluded the file in the backup
selection.

g Selected by useffilter The Backup Client user has applied a filter to the parent folder
or directory. That filter has included the file in the backup
selection.

[=] Excluded by user The Backup Client user hasexcluded the file from being

backed up to the Storage Platform.

[ %] Excluded by administrator The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform.

- Included by profiling The Backup or Storage Platform Administrator has included
this file or file type. Files displaying this icon will be backed up
to the Storage Platform and cannot be deselected from within
the Backup Client.
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Included by profiling filter

Excluded by profiling

Folder (not selected)

Some files selected by user

All files selected by user

All files selected by user,
some excluded

All files excluded by the
user

Filter applied by user

Filter applied by user,
some excluded

All files included by
profiling

Filter applied by profiling

Filter applied by profiling ,
all items excluded

ATTIX’

The Backup or Storage Platform Administrator has applied a
filter to the parent folder or directory. That filter has included
the file in the backup selection. Files displaying this icon
cannot be deselectedor excluded from within the Backup
Client.

The Backup or Storage Platform Administrator has excluded
this file or its file type. Files displaying this icon will not be
backed up to the Storage Platform and cannot beincluded in
the backup selectionfrom within the Backup Client.

The folder exists in the directory but it is not included in the
backup selection.

The Backup Client user hasincluded some filesin the backup
selection.

The Backup Client user hasincluded all files in the backup
selection.

The folder contains no unselected files. Each file is either
included or excluded.

The Backup Client user hasexcluded all files in the folder from
being backed up to the Storage Platform.

The Backup Client user has applied a filter to the folder. The
filter has included one or more files within the folder.

The Backup Client user has applied a filter to the folder that
hasincluded and excluded files within it.

The Backup Administrator has included all the files contained
in the folder. All files will be backed up to the Storage
Platform. These inclusions cannot be changed by the Backup
Client user.

The Backup Administrator has applied a filter to the folder.
This filter cannot be removed by a Backup Client user.

The Backup Administrator has applied a filter to the folder ,
resulting in the folder being excluded from the backup
selection. This filter cannot be removed by a Backup Client

user.
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&

Filter applied by profiling,
some items included by
user

Filter applied by profiling,
some items included and
some items excluded by
user.

Filter applied by profiling
but items excluded by

user.

Folder excluded by Global
Filter.

All files excluded by
profiling

Plug-in node (not
selected)

Some itemsselected by

user

All items selected by user
All items selected by user,
some excluded

All items excluded by user

Filter applied by user

The Backup Administrator has applied a filter to this folder

using profiling and some items have beenmanually included

by the Backup Client user(seefiSelecting data to back um

earlier in this chapter).

The Backup Administrator has applied a filter to this folder
using profiling . Some items have beenexcluded and others

included by the Backup Client user(seefiSelecting data to back

upoearlier in this chapter).

Items in the folder have beenincluded using filters (seefUsing

filters 0 earlier in this chapter.)

The folder has beenexcluded using Global Filters. For more

information, see Global Filters inCh apt er

settings. 0

8,

i Op

The Backup Administrator has excludedall files in the folder.

Theseexcluded files cannot be included by a Backup Client

user.

The plug-in exists but is not selected for backup to the Storage

Platform.

The Backup Client user has selected some of the items in the

plug-in for backup to the Storage Platform.

The Backup Client user has selected all items in the plugin for

backup to the Storage Platform.

The Backup Client user hasincluded and excluded items in the

plug-in.

The Backup Client user hasexcluded all items in the plug-in

from being backed up to the Storage Platform.

The Backup Client user has applied a filter to the plug-in;

specifying that certain file types must be included for backup

to the Storage Platform.
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lcon legend menu continued...

ﬁ' Filter applied by user, The Backup Client user has applied a filter to the plug-in;
some excluded specifying that certain file types be included for backup to the
Storage Platform but some items have beenexcluded either
through the use of an exclusion filter or by manual exclusion.

i) | Note: For more information, see Profiled selectonsi n Chapter 4, fGrap
(GUNDO and-inPhGlgapter -9ns Al ug
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It is useful to determine the backup selection size beforestarting the backup process to avoid

Over Limit errors.

The Backup Client compares your backup selection size with the Backup Account
limit (specified by your Backup Administrator) at the beginning of the backup process. If
the selection size exceds the Account limit, the backup process will stop and an Over

Limit error message will be displayed.

To calculate the backup selection size:

A. On the File menu, click Calculate Size.
B. Alternatively, click the Size button on the toolbar:

L

Restors Find Options  Autamate Help

Backup Size

The Backup Selection Size dialog box that appears displays total size of your backup selection

(i.e. all files included for backup) .

Backup set index prepared in < 15
Files and directories: 1 Taokal size: 24 bytes

Mandatory files: 0 Tokal size; 0 bykes

/v | Warning:  If your backup selection size exceeds your Account limit, you need to remove
some items from the selection or ask your Backup Administrator to upgrade your

Account limit.

Toremove a file from the backup selection:

A. In the Size dialog box, right-c | i ¢ k

that it is excluded: &.
To exclude multiple files at once, click a file name in the list, hold down the
Shift key and drag the mouse pointer to highlight the files. Right -click the

selection, and then click Exclude .

t h e ©fThd i@ will tirnc echto indicate

B. Alternatively, on the Backup Selection tab, deselect or exclude files or folders that are

currently selected for backup. For more information, see Selecting data to back up in

Chapter 5, fABackups. o
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Exporting a selection report

After creating a backup selection, you can export a list of allbackup inclusions and exclusions to
an html file for future reference.

The selection report will specify:
Files and folders included in the backup
Files and folders excluded from the backup
How each item was selected (userselected, filters, profiling or mandatory patching)
Where each item is located on the machine
The total number of items in the backup selection

To export a selection report:

1. Onthe File menu, click Export Selection
2. Inthe Save As dialog box, select the location in which to save the file, type a file name
in the File name box, and then click Export

The file will be saved to the specified location and can be viewed in any Internet browser.

€ C\Users\UsertDocumentsiBackup selection html - Windows Intermet Explorer EI@
UU |§ Cihlsers\User\DocumentstB | “9| b4 | |b Bing o -
{3 Favarites 3;5, 8 Suggested Sites €| Web Slice Gallery -
& C\Users\User\Docurnents\Backu... f‘:} * Bl v [ @ v Pagew ZSafety > Taonlsw '@" ”
-
ASBP Backup Set as on 19 Jan 2010 05:53 PM
Backup Account: BACKUP ACCOUNT 01
Backup Group: 4-5P OWHMNERIRESELLER &A\BACKUP ACCOUNTS
Storage Platform: 192,168.20.215
Backup Set Name: Default L
Backup Set Version: 6.0
Client Version: 6.0.0.685
Schedule

Duaily backups for this backup set occur at 11h04

Mo advanced schedule is defined.

Selections

Overview
There is 1 volume with selections:

. O
o 1 folder directly included
o 1 folder directly excluded
o 1 file directly included <

ia v 0% v
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It is recommended that you run a backup manually after creating your backup selection
to ensure immediate data transmission to the Storage Platform . Thereafter, automatic backups
will ensure hassle-free continuous backups. For more informat i o n, see fASche
b a ¢ k Uapesimthis chapter .

To star ta backup manually :
1. Onthe File menu, click Backup Now . Alternatively, click the Backup button on the
toolbar.

o

Backup

The Backup dialog box appears and displays the progress of the backup:

-

|E| Backup @

| Preparing backup

Connecting ko service
Skarting backup
Initializing secure random generator., .,

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue
will display in the Backup dialog box, enabling you to cancel the current backup in
favour of the next, should you wish to do so. For more information, see Multiple Backup
SetsinChapter 8, 6Ge@imgs.ioons and

2. To close the Backup dient after the backup process has started, click theHide button.
This will not cancel the backup process and the Backup Client can be r®pened at any
time to view the progress of the backup.

You can monitor the backup progress at any time by right -clicking the system tray icon
and then clicking Monitor Progress
To view backup logs, click the Logs tab. Backup log dates are displayed in blue.
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Automatic backups are usually enabled and configured during the Account Setup process (see
Step 5 of 7: Schedule Backup Processin Chapter 3 , i Account yo$eah enpbiepnd b u t
schedule them at any point in time using the Options and Settings  dialog box.

To schedule da ily automatic backups

1. On the Tools menu, click Options . Alternatively, click the Options button on the
toolbar.

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selected in the
Backup Set drop-down box. (For more information on backup sets, see Multiple
Backup SetsinChapter 8, AO0Opt.)dbons and settings

4. Select the Daily Automatic Backups check box and then specify a badkup time in
the Back up every day at  box.

5. Click OK.

To schedule advanced backups:

1. Onthe Tools menu, click Options .

2. Inthe Options and Settings  dialog box, click Backup Schedule

3. If multiple backup sets are enabled, ensure that the correct set is selectedn the Backup
Set drop-down box. (For more information on backup sets, see Multiple Backup Sets in
Chapter 8, AOpt.ibgnhs and settings

Select theAdvanced Schedule  check box.

In the Week Day box, select a day on which a backup should be initiated.

Specify the time in the Backup time  box.

Click the Add button to add the day and time to the Additional Schedule box.
Repeat steps5 to 7 above until you have added all desired schedules to theAdditional
Schedule box.

© N o oA

You are advised to back up at night w hen the server running the Backup Client is

not in use. It must be switched on at the scheduled backup time(s), but the
Windows user does not need to be logged in.

Configuring automatic backups ensures that all selected data is backed up
automatically, wit hout the need for any user interaction. This is a safer

alternative to relying on manual backups.
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Backups will initiate at the scheduled times and the Backup dialog box will appear displaying
the progress of the backup

|E| Backup

Sending backup

Connecting ko service

Skarting backup

Initializing secure random generator, ..

Connecking to Storage Platform on 192,168,20,215:443
Server name: Storage Platform, AtkixS Dey OA,

Building selection list

If Multiple Backup Sets are enabled and their backup windows overlap, a backup queue will
display in the Backup dialog box, enabling you to cancel current backup in favour of the next,
should you wish to do so. For more informatio n, see Multiple Backup Sets in Chapter 8,
fi O s and settings. 0

To close the Backup Client after the backup process has started, click theHide button.
This will not cancel the backup process andyou can re-open the Backup Client at any

time to view the progress of the backup.

You can monitor the backup progress at any time by right -clicking the system tray icon

and then clicking Monitor Progress

To view backup logs, dick the Logs tab. Backup log dates are displayed in blue.

| i Backup Selectiu:unl = Eestnre| =| Logs

19 1an 2010, 15:46:46 essage: 1546046 Tue, 19
19 Jan 2010, 15:44:22 essage: 15146145 05 Wini

19 Jan 2010, 15:38:45 | essage: 18:46:46 Using ba
essage: 15146046 Connect

Backups will be stored on the Storage Platform and accessible via theRestore tab. For more
information on restoring

data, see Chapter 6,

fRest
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By default, the Backup Client tries to connect to the Storage Platform four times before
cancelling the backup process. If, however, the previous backup was not successfuland a
manual backup is initiated, the Backup Client will display the prompt: Do yo u want to
resume the failed backup ... ?0with a 30 second countdown.

-

Canfirm resurme backup @

Do you want to resume the failed backup from Tue 19 Jan 2010, 18:51:507
(A new backup will stark in 28 seconds)

| Yes || Mi || Cancel |

Click Yes to instruct the Backup Client to try to continue from where the process fail ed during
the previous backup. Click No to initiate a new backup or Cancel to return to the Backup Client
application window.

A new backup will be initiated automatically after the countdown has elapsed.
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On the Restore tab, you can browse a tree structure representation of all successful backups
and their files and folders.

The following sections describe how to select data to restore, start the restore process, and
search for specific backed up files.

On the Restore tab, the Restore tree gives you access tdacked up files via two main nodes:
Last Backup and Previous Backups

2 rest The Last Backup node contains the file/folder
| i 5 esfare =
| " Ry SElectmn| - Iﬁl structure of the last successful backupand displays

EM the date and time it occurred in parenthesesfi (. ) 0
[ =4 Last Backup (19 Jan 2010, 18:52:25]!|
el C .
i a i) Restores done from the Last
Lo le Workspace i
Backup node are typically faster than

=I-§ ' Previous Backu i
| L Previous Backups | those done from the Previous Backups

19 Jan 2010, 114427

19 an 2010, 11:43:08 backups from the Storage Platform and displays

them in the tree.

+-]_ 19 Jan 2010, 18:51:40 .

+:t 19 Jan 2|:|an 18:51:17 node as the Backup Client may be able to
- oo retrieve the data from the cache instead

+-) 19 Jan 2010, 18:46:16 the Storage Platform

+-) 19 Jan 2010, 18:38:15 9 '

+-) 19 Jan 2010, 17:40:25

#0019 Jan 2010, 1713953 When you expand the Previous Backups node,

- 19 Jan 2010, 11:44:55 the Backup Client retrieves the list of previous

+...L_

+...L_

To select and restore data  from the

1. Click the Restore tab.

2. Expand the Last Backup node to view the files/folders.

3. Include a single file by clicking the ' icon next to the file or by right-clicking the file
name and then clicking Include . Eachincluded file is displayed with a green icon: ¥

4. Include an entire folder by right-clicking the folder and then clicking In clude folder .

Eachincluded folder is displayed with a green folder icon: L.
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5. If an entire folder is included but you wish to exclude a particular file or
subfolder, right -click the file or folder icon, and then click Exclude or Exclude
Folder . Excluded items are displayed with red icons: & or £¥. Included folders that
have some files or subfolders excluded are green with a red tint: £
6. Once all the files and folders to be restored are selectedstart the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on the restore options available, seefiRestoringdatad | at er i n this cha

To select and restore data from

1. Click the Restore tab.

2. Expand the Previous Backups nhode to connect to the Storage Platform and retrieve a
list of all previous backup dates.

3. Expand the relevant backup node, and then click the folder/directory containing the
data.

4. Include a single file by clicking the T icon next to the file or by right-clicking the file
name and then clicking Include . Each included file is displayed with a green icon:

5. Include an entire folder by right-clicking the folder and then clicking Include folder .
Each included folder is displayed with a green folder icon: L=

6. If an entire folder is included but you wish to exclude a particular file or
subfolder, right -click the file or folder icon, and then click Exclude or Exclude
Folder . Excluded items are displayed with red icons: & or £¥. Included folders that
have some files or subfoldersexcluded are green with a red tint: =

7. Once all the files and folders to be restored are selected, start the restore process by
clicking Restore on the File menu or the Restore button on the toolbar. For
information on t he r es Resworimgdatadtbglovns avail abl e, se
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After you have selected the files and folders to restore, you canstart the restore process as
described below.

To start the restore process.:

1. On the File menu, click Restore . Alternatively, click the Restore button on the

toolbar:
Backup Size Restare F|n-:| Cptions  Autornate  Help

The Restore dialog box will prompt you for a restore location :

Save files in:

Criginal location

@ Folder: |[CHiUsers\UseriRestore Browse

2. SelectOriginal location  to restore the files to the same location that they were backed
up from or selectFolder and then browse to a new location.

1. | Warning:  If Original location is selected the restored files will overwrite
any existing files with the same name in that location. A warning will, however,
be displayed before the Backup Client overwrites any files.

In the Options area, specify the restoreoptions.

Options
/| Recreate directory skruckure
| Restore empty Folders
Crverwrite Files
| Use compression (Faster over the Inkernet)
| Restore file and folder permissions

Restore directly to target location (Faster, but resume on file level nok possible)

For more information on restore options,

3. Click OK.

S

e e

t

h e
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Restore options

Recreate directory

structure

Restore empty folders

Overwrite files

Use compression

Restore file and folder

permissions

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .

By default, the folder structure is recreated in the Restore
folder. To specify that all files be restored to one location, clear
the Recreate folder structure check box

._iu) Note: If restoring files from different folders with the
same file names, you need to recreate the folder
structure to prevent overwriting the files.

To restore all empty folders within the directory structure,
select the Restore empty folders  check box Clear the
check box to restore only those folders containing backed up
files.

l/ Note: This option is only available when Recreate
directory structure is selected.

Selectthis option to prevent the Backup Client displaying a
prompt before overwriting existing file s.

N
!

/¥ | Warning: I this check box is selected, files with

matching filenames in matching directories will be
overwritten without warning.

Select theUse compressioncheck boxto enable the Storage
Platform to compress files beforetransmitting them to the
Backup Client.

\J Tip: You are advised to enable this setting when
restoring over a slow Internet connection as it will
reduce the size of the files, making the transfer
process faster.

Clear this checkbox to prevent the Backup Client restoring file
and folder permissions. You would typically only select this
option after a complete server failure (to restore files before
user accounts are recreated).
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Restore options continued...

Restore directly to target

location

Select this check box to write files directly to the specified
folder without using a temporary working folder. The restore
process is faster using this option due to less disk access.

However, a file-level resume is na possible. Should there be a

communication error during a file transfer, the complete file

will be resent.

1}) Note: You can view restore logs on the Logs tab. Restore log dates are displayed in

green.

|| i Backup Selection | il Restore | =/ Logs

19 1an 2010, 15:46:46
19 Jan 2010, 184422

Message: 15:46:46 Using ba
Message: 15:46:46 Connect

essages 15146046 Tue, 19
essage: 15:46:46 05 Win

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .
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To find a specific backed up file, it may be easier to use theFind function than to browse the
Restore tree.

You have the option to scan only your last backup (locally), or you can connect to the Storage
Platform and search through previous backups.

To search for afilein  your latest backup:

1. On the File menu, click Find files in backups . Alternatively, click the Find button
on the toolbar:

L1990 e e e

Backup Size Restors Find Options  Autamate Help

2. Type the file name or part thereof in the File name box, and then click Find .

File name {Full or partial): sales|

@ Search last backup (local)

1 Search through previous backups (Storage PlatFormn)

Search backup dates

[ Limit number of results to: |10

| Find

= If fsalesdis searched for, the Backup Client will display a list of all files in the
| ast backupsaedni ai hhegf il ename.

Use the* and ? wildcards for advanced search queries.
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To search for a file in previous backups:

1. On the File menu, click Find files in backups . Alternatively, click the Find button
on the toolbar:

AN I ONON?

Backup Size Restore Find Options  Automate Help

2. Type the file name or part thereof in the File name box.

3. Select theSearch through previous backup s (Storage Platform) check box.

4. If you wish to limit the search to particular dates, select the Search backup dates
check boxand then use the Start date and End date boxes to specify a time period.

5. To limit the number of results that display, select the Limit number of results to
check box and thentype anumber in the box provided.

6. Click Find .

File name (full or partial): | sales

1 Search last backup {local)

@ Search through previous backups {Storage PlatForm)

Search backup dates

Start date: |01-01-2010 lEJ PR-dd-
End date: |01-19-2010 lEJ FM-dd-y

Lirnit numnber of resulks ko (10

Use the* and ? wildcards for advanced search queries.

i) If Search backup dates is selected the backup date is used for the search
instead of the file create or file modified date.
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To restore files from the Find Files in Backup dialog box:

1. Inthe search results list, include the files to restore by clicking the icons next to the file

names or by right-clicking each file name and then clicking Include
2. Click the Restore button.

File name (full or partial); | sales

@ Search last backup (local)

1 Search through previous backups (Starage Plakform)

Search backup dates

[ Limit nurnber of resulks bo: |10

Find
Search result

_ | Falder | Filename |5 | Date _|_Fi... _|_Ban:k... |
f"' _____ Zi\Users\Bashier. .. salesMow2009, bxt OKE 19/01/20... kxt 19/01)20...

_________ . ..saleslanz0i0bxt  OKE 19/01/20.. bt 19/01/20...
) Ci\Users\Bashier. .. salesDec2009, bxt OKE 19/01/20... kxt 19/01)20...

Restu:urE

The Restore Options  dialog box will appear, enabling you to specify the location in which the
save the restored fil

es. For more informat.i
earlier in this chapter.

on on r e s
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Restoring a backup  selection

By default, with every backup performed, a copy of the backup selectionis saved on the Storage
Platform. For more information on backup selection, see fiSelecting data to back up earlier in

this chapter.

This enables you to restore, not only your backed up files and folders, but the selection you used

to back them up as well.

i) | Note: This is especially useful in disaster recovery cases, as it enables you to restore
your entire backup setup to perform exactly as it did at the last backup.

To restore a backup selection:

1.

Click the Restore tab.

2. Expand the relevant backup folder, and then click the Workspace node.

3.

The backup selection will be restored to the location specified in the restore options.

| il Backup 53Iectinn| ol Restore | =] Logs

i Backups
El--’.___'. Lask Backup (19 Jan 2010, 19:12:50)

In the right -hand pane, click the icon next to the name of the backupset to include it for
restore. If you have not enabled Multiple Backup Sets (seeMultiple Backup Sets in
Chapter 8, MAOptoi)onsi nacnl du dseethbtlisplagesn |y

Filename

O Include
& Exchd
1 Deseleck

Click the Restore button on the toolbar.

Select the appropriate restore options. ( Se e

chapter.)
Click OK.

nSel

ecti

ng

entry

dat a

t

(o]

resto
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The Backup Client logs all backup and restore processes and their results in log files thatyou can
view on the Logs tab. The following sections describe how to access log filesand modify their

settings.

The Logs tab in the Backup Client provides detailed information about each backup and
restore. An additional toolbar button appears when the Logs tab is opened: the Summary

button. Use the button to view only errors and warnings and the last 14 lines in the log file.

i

[Ea] 2t Pra SE W6.0.0

File Selection Tools Help

Backup Size

Restore

A0 D0@O@®

Find

Options  Autornate  Help

| & Backup Selection | = Bestu:urel =| Logs

19 Jan 2010,

19 Jan 2010, 18:52:23
19 Jan 2010, 158:52:11
19 Jan 2010, 158:51:43
19 Jan 2010, 15:46:46
19 Jan 2010, 184422
19 Jan 2010, 15:53:45
19 Jan 2010, 158:53:35
19 Jan 2010, 15:11:34
19 Jan 2010, 17:40:55
19 Jan 2010, 1740022
19 Jan 2010, 11:453:23
19 Jan 2010, 11:44:55
19 Jan 2010, 11:43:36
19 Jan 2010, 11:40:42
19 Jan 2010, 11:40:29
19 Jan 2010, 11:04:04
19 Jan 2010, 11:03:24
19 Jan 2010, 11:02:03
19 Jan 2010, 11:01:03
19 Jan 2010, 09:355:00

m

Errors and warnings

Lask few lines of log File

Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:
Message:

1912153 -mmmmmmmmmmmmmme e Technical Data --------
19:12:53 Backup prepared in: 00:00:01

19:12:53 Mew files: &; 16.3 KB {comp: 0.2 KB)
19:12:53 Remaved files: 0; 0.0 KB

19:12:53 Patched files: 1; 0.5 KB + 0.2 KB --= 0.
19:12:53 Skipped files: 0

19:12:53 Disk usage drive C: 31% full, 12.42 GB/
19:12:53 Cache using 434 byvtes { < 1% of disk sf
19:12:53 Temp dir using 2.0 KB (< 1% of disk spz
19:12:53 ---------m-- - Data Transmitted ------
19:12:53 Mo Meed ko transmit; 0.0 KB

19:12:53 Transmitked during compression: 0
19:12:53 Transmitted after compression: 2,0 KB i
19:12:53 ========== Backup Summary ===
19:12;53 Total selection: 1.4 KB in 11 files and fo
19:12:53 Total backup time: &s

19:12:53 Backup Status: Successful
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You can specify your logging preferences on the Logging pagein the Options and Settings
dialog box.

Modifiable settings include:
level of detail included
date inclusion/exclusion in time stamp
log file retention period

For information on configuring the log file settings, see Logging in Chapt er 8, AOptions
settings. 0



To access the Options and

On the Tools menu, click Options . x

ATTIX’

Settings dialog box

Alternatively, click the Options button on the toolbar:

139

Backup Size Restore Find

Zptions

© &

Autarnate Help

The various options and settings are grouped in the left-hand pane according to their functions.
Click an item on the left to view the full set of options related to that function.

L §

Example:
on the right:

Click Advanced Options

in the left-hand pane to view all advanced options

Options and Settings

" Account and Security

Advanced Options

=)

" Advanced Options
Backup Process

Use Y35 to update the cache,

resulting in cache update Failures,

Retries and Timeouts

Duration between connection retries (seconds):

Socket timeout (seconds):

) Connections

1 Backup Schedule Communications

) Backup Throttle

) Display Always connect to the Storage Platform during the backup process.

) Disk Usage Mote: Enable this option ta slways update the Storage PlatForm with the last backup date, even
" Performance and Limits if there were no changes ta the backup selection.

1 Global Filters N

T Patching [] complete compression/patching before sending data ko the Storage Platform,

) Mandatory Patching verify account limit before compression/patching.

) Logging

[ Enable Yolume Shadow Copying (%SS) to back up locked files,

Using this option will increase the speed of the cache update pracess. It will hawewver also
increase the load on ¥S35 and may cause Y535 ko Fail on servers with heavy 1O (ke file servers),

[ Use MTFS Change Journal for supported volumes

Mumber of Backup/Restore attempts before cancelling: jl 04

=
=

Ok ” Cancel H Help ]

Warning:  The Options and Settings

dialog box controls advanced features in the

Backup Client. Please read through this section carefully before changing any settings.
Incorrect settings could cause critical errors.
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You can use the Account and Security page in théptions and Settings

dialog box to:

Update Account information
Change your password, encryption key or Account setup properties
Modify Client security settings

Options and Settings

Account and Secority
Connections

Account and Security

Backup Schedule
Backup Throttle

Display

Disk Usage
Performance and Limits
Global Filkers

Patching
Mandatary Patching
Logging

Advanced Options

Account Information

Backup Account:
Backup Group;
Storage Plakform:

Waur current account limik is:

BACKLP ACCOUNT 01
A-3P OWHERRESELLER AVBACKIIP ACCOUNTS
192,168.20,215
512 MB
Click on Retrieve 3ettings to conneck to the Retriove Sethings
Storage Plakform and retrieve the account settings. 2

fAccount Setup

From this section, vou can change your password or encryplion key and run the Setup Wizard,
should wou wank to create a new account or reconneck to an existing one,

hange Password ] [ “hange Encryption Keyw ] [ Fun Setup izard

Security Settings

Specify whether the Backup Client should remember the Backup Account password during the backup
or restore procedures,

@ Remember password For backup and restore
() Prompt for password on restore

_ Prampt For password ko open the Backup Client and b restore, (IF vou Forget the password
= wou will have to reinstall the client)

Ok ” Cancel H Help
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The Account and Security page consists of the following areas:
Account Information area
Account Setup area
Security Settings area

This area displays your Backup Account information as it is configured on the Storage Platform.
You can use theRetrieve Settings  button to update your Account settings.

This button is useful to verify that the Account limit has been modified after
requesting a change from the Backup Administrator, or to update Backup Group
Profiling settings.

If you need to change your password or encryption key, click either the Change
Password or Change Encryption Key button. To change your Backup Account settings,
click the Run Setup Wizard  button. For more information, see Account Setup Wizard in
Chapter 3, AAccount setup. o

1, | Warning:

Changing the encryption key involves intensive processing on the Storage
Platform and may take several minutes. You should avoid doing this unless the
encryption key has been compromised.

Disaster recovery is not possible without the encryption key. Please ensure that
this key is kept in a safe place. THIS ENCRYPTION KEY IS NOT STORED ON
THE STORAGE PLATFORM AND CANNOT BE RECOVERED OR RESET IF
LOST.

The Security window allows you to select whether the Backup Client should remember the
Backup Account password when running a backup or a restore.

There are three options available:

Remember password for backup and restore : The Backup Client remembers the
Backup Account password when doing a backup or restore. This is the default setthg.
Prompt for password on restore : The Backup Client prompts for the Backup
Account password during the restore process.

Prompt for password to open the Backup Client and to restore : The Backup
Client prompts for the Backup Account password when opening the Backup Client and
the Restore tab.
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Connections

You can use theConnections page in the Options and Settings  dialog box to:
Modify Storage Platform connection settings
Enable/disable/configure proxy server details

Options and Settings @
| = i =
- Connections
) Backup Schedule Connection Settings
) Backup Throttle
) Display Use this section to change your connection settings, These settings were configured in the Setup
) Disk Usage Wizard during the installation process.
) Performance and Limits (@ Use network connection
1 Global Filters
1 Patching () Use dial-up connection
) Mandatory Patching - -
© Logging Dial-up 3ettings. ..
=

Advanced Options

Proxy Server

If vou use & proxy server For yvour Inkernet connection, you will probably have to supply the same
proxy server infarmation in the Backup Client,

@ Mo procy

() Use HTTP proxy

() Use SOCKSYS Proxy

Proxy Hosk: Procey Port: (10050

Proocy server requires aukhentication

Usernarme:

Password;

ik ][ Zancel ][ Help

Attix5 Pro V6.0 Copyright © Attix5. All rights reserved .
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The Connections pageconsists of the following areas:
Connection Settings area
Proxy Server area

In this area, you can change the type of connection that the Backup Client uses to connect to the
Storage Platform. You can choose between a network/permanent or dal-up connection.

i) The Dial -up Settings button is enabled if you select Use dial -up connection
Click this button to select an existing dial -up connection configured on the computer, and
then supply the username and password for that Internet conn ection.

In this area, you can specify whether or not the Backup Client should connect to a proxy server
when connecting to the Internet. If you select that it should, you can specify the proxy server
details in the relevant boxes.
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Backup S chedule

You can use theBackup Schedulepage in the Options and Settings  dialog box to:
Enable/disable daily automatic backups
Create advancedautomatic backup schedules

Options and Settings @
1 Account and Security Backup Schedule
) Connections : — i
) Backup Schedule r .

) Backup Thrattle Barkup Set: Default ~ ch 38 [

—~

D!splay Automatic Backups

) Disk Usage

" Perfarmance and Linits Daily automatic backups

) Global Filkers

) Patching Back up every day at: :l 11ho4 @

) Mandatory Patching

) Logging [7] advanced schedule

) Advanced Options Back up at the Following tirmes

Week Day Additional Schedule
Mu:nnddav Backup time:
Tuesday
12h00 @

Wednesday :‘
Thursday add
Friday
Saturday Delete
Sunday

ik ][ Zancel ][ Help
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The Backup Schedulepage consists of theAutomatic Backups area.

i) If using Multiple Backup Sets, u se the Backup Set drop-down at the top of the
dialog box to specify which backup set schedule you wish to configure. For more
information, see Multiple Backup Setsin Chapt er 8, fAOpt.idns an

In this area, you can enable or disable automatic backups.

To disable automatic  backups (not recommended)

1. Clear the Daily automatic backups check box
2. Click OK to close the Options and Settings dialog box

1. | Warning:  This option is not recommended. If an automated backup scheduleis not
created, backups will have to be run manually . Enabling automatic backups is

strongly advised .

For detailed instructions on how to enable and schedule automatic backups, seeScheduling
automatic backupsi n Chapter 5, ABackups. 0
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Backup Throttle

You can use theBackup Throttle page in the Options and Settings  dialog box to specify the
Client's bandwidth usage speed limits by creating a backup throttle schedule. Backed up data
will then only be transferred at the specified speed limits during each interval.

Options and Settings -H

) Account and Security Backup Throttle

) Connections : i

) Backup Schedule Speed Limits

E‘ Bgckup Uiiie Specify one or more speed limits (in kilobytes per second) that can be used when sending backup data
Display ko the server, & limit of O indicates that no limit will be applied.

) Disk Usage

1 Performance and Limits . Lirmik 1: ol= kefs . Lirmiit 2+ 0/ keys

) Global Filkers = -

O Patching B it = ofskeis [ it 4: o2 keys

) Mandatary Patching Limit 5: 0l kBls . Lirniit 62 012 kBfs

) Logging

) Advanced Options Throttle Map

Selected speed limit:
(Click to cycle)

Interval: 60 | minutes

1 3 5 7 9 11 13 15 17 19 21 23
MMonday
Tuesday
Wednesday

Thursday
Friday
Saturday
Sunday

l Clear ” Defaulk

Ok ” Cancel H Help
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The Backup Throttle page consists of the following areas:
Speed Limits area
Throttle Map area

In this area, you can specify one or more speed limits (in kilobytes persecond) that can be
applied when sending backup data to the server.

To specify a speed limit:
Choose a colour to represent the limit and specify the limitint hat clonitohox. 6 s
You can now schedule the speed limits in the Throttle Map area as descted below.

i) A limit of O indicates that no limit will be applied.

In this area, you can indicate when the speed limits specified in the Speed Limits area should
apply. By default, the graph displays 60 minute intervals and different colours representing the

standard work week, weekend days, and office hours. You can eitkr set speed limits for the
colours displayed by default or you can click the Clear button and create a new map.

To schedule speed limits:

1. Specify the interval to be used in the Throttle Map in the Interval box.
2. Inthe Speed Limits area, click a speed limit colour.
3. Inthe Throttle Map area, click the schedule interval boxes you wish to apply the limit to.

The graph will colour, depending on the limits chosen.
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Display

You can use theDisplay page in the Options and Settings  dialog box to select your Backup
Client display preferences.

Options and Settings @

il SEcurity
Displa
) Connections play

Backup Schedule Selection Table
Backup Throttle
' Display [ Display File Type column in selection table.
Disk Usage
Performance and Limits Display folders in selection table,
Global Filkers
Patching
Mandatory Pakching
Logging
Advanced Options

sllalolallalalal  [aXe]

ik ][ Zancel ][ Help
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The Display pageconsists of a Selection area thatprovides you with the following options:

Display File Type column in selection table - Adds aFile Type column to the
right -hand pane.
Display folders in selection table - Enables the right-hand page on theBackup

Selection tab to display subfolders.
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You can use theDisk Usagepage in the Options and Settings  dialog box to:
Move the working folders and cacheto a different location
Specify the number of days that files are to be kept in the cache

Options and Settings

Account and Secority
Connections

=3

Disk Usage

) Backup Schedule
" Backup Throttle

Display

" Disk Usage
Performance and Limits
) Global Filkers

Patching
Mandatary Patching
Logging

Advanced Options

Waorking Folders

¥ou can move the Cache, Log, Temporary Folders and the Selection Database ko another location if
there is limited space available on the drive where the Backup Client is installed.

Moke: Ahways keep these folders on the same drivevolume,

Temp: C:\Program Files\attixS Pro\Backup Client SE\toBackup Browse. ..
Cache; Ci\Program Files\AttixS ProtBackup Client SE'cache Browse, .,
Logs: C:\Program Files\attixS Pro\Backup Client SEllogs Browse. ..

Dakabase: C:\Program Filesiattizs ProtBackup Client SE Browse, .,

Cache

Changed files are compared to the previous version ka anly transmit patches. The longer files are
kept in the cache, the better the chance of transmitting patches instead of Full copies,

Davs to keep files in Cache: :l 20 Clear Cache. ..

Ok ” Cancel H Help
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The Disk Usage page consists of the following areas:
Working Folders area
Cache area

If you have limited space on the drive where the Backup Client is installed, you can move
the Cache, Logs and Temporary folders as well as the selection database to another location.

Temp - Used for temporary workspace when the files are patched, compressed and
encrypted.
Cache - Keeps a local, compressed and encrypted, copy of theselected files for a
specified number of days.
Logs - Stores all backup and restore logs.
Database - Compares the latest backup selection with the previous backup to
determine the changes.
1. | Warning:
The Cache and Temp folders must reside on the same drive/volume.
If the database or any of the folders are stored on a network share, please

ensure that the Backup Service has the correct permissions to connect and write
to that share.

When modifications are made to a file, the Backup Client only transmits changes to that file, as
opposed to transmitting the complete file again. This is accomplished by the use of a local cache.

By default, recently modified files are kept in the Cache for 20 days, after which they will be
deleted. Once a file hasbeen flushed from the cache, a full copy will be backed up when any
modifications are made to the file. The longer files are kept in the Cache, the better the chance of
only transmitting patches instead of full copies and thus reducing the amount of data that needs
to be transmitted. If there is limited disk space available, consider shortening the time files are
kept in the cache.

i) If you specify O days for caching, patching is disabled. All files in the Cachewill
be deleted, andfull copies of changed files will be transmitted to the server during each
backup.

To delete the current cache, use theClear Cache button. If the cache is deleted, full copies of
the selected files will be re-sent to the Storage Platform during the next backup.

i) The Backup Client will log the message Doing monthly cache cleanup once a
month. This maintenance task is to ensure that there are no redundant files in the Cache.
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You can use thePerformance and Limits page in the Options an d Settings dialog box to:
Increase/decrease BackupClient processor usage
Increase/decrease Backup Client disk accessisage
Set data transfer limits
Ensure that a certain amount of free spaceis always left on the hard drive

Options and Settings

) Account and Security
Connections

Performance and Limits

Backup Schedule
Backup Throttle

Display

Disk Usage
Perfarmance and Limits
Global Filkers

Patching
Mandatary Patching
Logging

sllefalalle]l  [eXelleolella]

Advanced Options

Processor sage & Disk Access

If wou experience any performance deterioration during the backup process, wou can lessen this
effect by lovering the processor usage and disk access of the Backup Client,

Processaor Usage: U
Ly High
Disk Access: rJ
L High
Lirnits

This section allows you ko manipulate the data transfer during the backup process if vou have ko limit
the transfer in any way.

[] restrict size of each backup (MBE): :‘ 10

Cycle backup process until all selected data has been transferred. The backup process
will be repeated until the complete backup has been transferred ko the Skarage PlakForm,

Free Space

Ensure that the Backup Client does not use all available hard drive space during data dumps,
patching or compression,

[ Enforce free space (GE): :l i0

Ok ” Cancel H Help
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The Performance and Limits page consists of the following areas:
Processor Usage & Disk Access area
Limits area
Free Space area

The Backup Client uses a fair portion of the available processor power to patch, compress and
encrypt files during the backup process. If you use the computer at the same time, you may
experience some performance deterioration. You can lessen this effect by lowering
the Processor Usage

1. | Warning:  If you use the highest Processor Usage  setting, it will affect server
performance during the backup.

Disk Accessis another setting that you can modify to limit performance deterioration. If you
use the High setting, the Backup Client will continuously use all available disk access to read
and write to the disk, ensuring that the process completes asquickly as possible. The process
will take longer if this setting is lowered but other disk -intensive applications will perform
better.

Select the Restrict size of each backup (MB) check box and specify a maximum value to
limit the total amount of data that may be transmitted to the Storage Platform during each
backup.

i) If this option is enabled , it may take several backups before all files are backed up
to the Storage Platform. This feature is especially useful when using a slow Internet
connection and ther e are problems with transmitting large backups.

Cycle backup p rocess... T You can use this settingin conjunction with the backup size
restriction to cycle backups successively until all dataincluded in the backup selection has been
transmitted to the Storage Platform. This setting can only be enabled if a backup ske restriction
has been specified.

To ensure that the Backup Client does not use all available hard drive space during data dumps,
patching or compression, you can select theEnforce free space check box, and then specify
the maximum amount of disk space the Client will be allowed to use.
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Global Filters

You can use theGlobal Filters page in the Options and Settings
Exclude files globally
Exclude folders globally

dialog box to:

Set up a No Compression filter

Options and Settings

1 Account and Security

X5

Global Filters

) Connections
™ Backup Scheduls Exchude Files
-
= B..acklup Thratte ‘o can specify file extensions that must be excluded From the selection list at all times, Files can also
- D!SE ay b excluded according to their modified date,
Disk LIsag8 o Mote: Swstem exclusion filkers are marked with a different icon in the Backup Client and cannok be

) Performance and Limits selected for backup.
= Global Filkers
) Patching [T Exclude these files:
) Mandatory Patching
€ Logging Examples:
) Advanced Opions file?,doc

video®  *

*.mp3

specific, avi

[7] Do not back up files older than: i, dd-mm-yyyy )

Exchude Folders

Specify Folders that should be excluded From the backup selection, no matter where they are located
on the available drives or volumes, Note: no wild cards or path separatars are allowed.

[ Exclude these Folders:
Examples:

Ty Music
Data
Photas

Mo Compression Filker
¥ou can specify file extensions For which no compression will be used. This is a global setting.

Do nok compress these file types:  |*.zip;*.cabg* gz ™. bz * rpm; . jpg; * rar . 72 % aif ;% . png

ik ][ Zancel ][ Help
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The Global Filters pagein the Options and Settings  dialog box consists of the following areas:
Exclude Files area
Exclude Folders area
No Compression Filter area

In this area, you can specify that files with certain file names, extensions or last modified dates
be excludedfrom all backup selections.

To exclude files based on  their file name s or extension s:

1. Select theExclude these files check box.
2. Type the file extension(s) and/or file name(s) in the box provided; separated by
semicolons or listed beneath each other.

v You can use wildcards. E.g. *.mp3 will exclude all MP3 files from backups.
< To exclude all MP3 and AVI files, specify *.mp3;*.avi in the text box.
Separate entries with a semicolon.

3. Click OK.

To exclude files based on their 'last modified’ date S:
1. Select theDo not back up files older than check box.
2. Inthe box provided, type the date in dd-mm-yyyy format.
3. Click OK.

In this area, you can exclude certain folders from all backup selections.

To exclude folders:

1. Select theExclude these folders  check box.
2. Type the folder names in the box provided; separated by semicolons or listed on
separate lines.

i) Wildcards are not supported in this area.

3. Click OK.
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In this area, you can specify the file types that the Backup Client should not compress during the
backup process.

Compression is not effective on all file types as some files may already be
compressed or cannot be compressed at all. The Backup Client could spend some time
and cause high processor usage trying to compress these files. This filter can be used
to specify a list of file extensions that should not be compressed during the backup
process. The list of file types already specified are types that typically do not compress
well.

To exclude files from compression:
1. Select theDo not compress these file types check box.
2. Type the file extensions in the box provided, separated by semicolons.
3. Click OK.



You can use thePatching page in the Options and Settings  dialog box to:
Enable/disable Delta Blocking
Enable binary patching limits

ATTIX’

Options and Settings

) Account and Security

=3

Patching

Advanced Options

) Connections

) Backup Schedule Delta Blacking

" Backup Throttle

1 Display Delta Blocking is Faster than Binary Patching and does not need a complete copy of the file in the
) Disk Usage cache. It will however create larger patches and therefore use more disk space on the Storage
) Performance and Limits Platform.

1 Global Filkers [] Enable Delta Blocking For:

" Patching

) Mandatory Patching Files larger than 1.0 GE

) Logging o (gither condition)

=

(@ and (both conditions)

Files with these extensions:

Binary Patching Threshaold

3ome data files can change significantly from one backup to the next, resulting in large, inefficient
patch files, Setting a patch abort threshold enables wou to abort such a patch and transmit the
complete file bo the Storage Plakform inskead, saving processing time.

[7] Enable patching limits

abort threshold: 1.0 GB

Moke: This option is useful for databases that are re-organized periodically and cause the backup
window ko be exceeded,

Ok ” Cancel H Help
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The Patching pagein the Options and Settings  dialog box consists of the following areas:
Delta Blocking area
Binary Patching Threshold area

Delta Blocking is an alternative to Binary Patching and compares changes on a block level. It is
significantly faster than Binary Patching and does not require a complete copy of a file in the
Cache to @lculate the patch, only a footprint file. The footprint file requires very little free disk
space- only 0,0006% of the original file. However, Delta Blocking patches are much larger than
Binary patches.

i) Pleaseread through this section before enabling this option in the Backup Client.

To enable Delta Blocking:

1. Select theEnable Delta Blocking  for check box.

2. The Delta Blocking file selection criteria can be set in two ways: either by file size or by
file type. Select the applicable condition(s) and supply the necessary information. Any
recently changed files not matching these criteria will be patched using Binary Patching.

v | Warning:  Some database files may not be suitable for Delta Blocking since data is
shifted at the beginning of the file. When this happens, it will result in a patch as large
as the complete file. It is advisable to closely monitor the sizes of the patches when Delta
Blocking is enabled and disable it if it turns out to be ineffective.

Binary patching is the most effective form of patching. It is very CPU intensive but will deliver
the smallest patches. The process is only possible if a complete copy of an older version of the
file is available in the Cache.

i) Binary Patching is enabled by default and nothing needs to be configured in this
tab for normal use.

Enabling patching limits . It is possible that a file could be modified in such a way that it
becomes impractical to patch it. An example would be a database that is reindexed.

In such a case, the patching can take extremely long (it may exceed the backup window) and will
eventually create a patch that is the same size as the complete file. It is better to abort the
patching and compress the new file instead. The patching limit indicates when the Backup
Client will decide to abort the patch and send a full copy of the file instead. When this amount is
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reached, patching will be aborted and the complete file will be compressed and resent to the
Storage Platform.

To specify patching limits:

1. Select theEnable patching limits check box.

2. Inthe Abort threshold  box, specify the abortthreshold (in gigabytes).

When this limit is reached, patching will be aborted and the complete file will be
compressed and resent to the Storage Platform.

Patching Limits should only be enabled if you have severe patching problems
with large files.
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Mandatory Patching

You can use theMandatory Patching page in the Options and Settings

dialog box to instruct

the Backup Client to scancertain files, regardless of whether or not they appear to have changed

since the last backup (i.e.eveni f

Tip: This is useful in situations where files are held open by an application (internally
the file changed, but the change is not reflected in the last modified date on the file

the filebs

system or in the size of the file itself).

ti me)st amp

remai

r

Options and Settings

Account and Security
Connections

X5

Mandatory Patching

Backup Schedule
Backup Throttle

Display

Disk Usage
Performance and Limits
Global Filkers

Patching

' Mandatory Pakching

Logging

slfa] i [allaYeXelellaXalla]

Advanced Options

The Following Files will be scanned For changes regardless of whether
they appear to have changed since the last backup.

Remove

ok

][ Zancel ][ Help
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Files selected for mandatory patching display on the Backup Selection tab with a green icon
containing tWMe Jetter fAMO:

i Backup Selection | " | Restnrel =| Lngs|

3 My Computer . | Filenarne
=8 r_ C . k= My Music
f-| 656bb94esb71SH | | = mMy Pictures
El't: Documents and 54| ¢ deskkop.ini
El't: Au:!ministratu:ur |ﬁ' Registerd, bxt
[#--h " Applicatio
---L_'. Cookies
-4 Desktop
[#-} Favorites
-} Local Sett
EI'L: My Dacun
) My Fi

i) | Note: You can manually exclude files specified for mandatory patching. For more
information on inclusionsand e x c | u Seélextmgdata wbdack upd ear | i €
chapter.

To select files for mandatory patching:
1. Click the Add button.
2. In the Open dialog box that appears, navigate to and select the file(s) and then click
Open . The file(s) location(s) will display in the Mandatory Patching list .
3. Click OK to saveyour settings.

.
)

Tip . Select more than one file at a time by holding down the SHIFT key and selecting
the files with your keyboard or mouse.
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Logging

You can use thelLogging page in the Options and Settings
preferences.

Modifiable logging settings include:
level of detail included
date inclusion/exclusion in time stamp
log file retention period

dialog box to specify your logging
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